eCol_oTrain

Translation Memory Module
Exercise 111

Creation and Maintenance ofa TM

Prerequisites

For being able to complete the following exercise you need to have gone at least through
courses | and 11, included in our Translation Memory Module.

You also need to have installed on your computer DéjaVu X and Microsoft Office Word. The
screen shots used to illustrate several steps of this exercise were taken from DéjaVu X.

1. Outline of this exercise
On completion of these exercises, you should be able to:

Create a stand-alone TM using Déjavu X

Import an existing TM into the newly created TM
Maintain the TM

Reorganize and compact the TM

Export the TM into the standard exchange format TMX

2. Preparing your working environment

Before starting to work with DéjaVu X, prepare your working environment by creating the
folder structure you will need to save your new translation memory and the results of the TM
export.

o First, create in your working folder My Documents the subfolder “CAT tools”

e Download the subfolder “Creation_Maintenance.rar” from our eCoLoTrain
webpage, save it under My Documents/CAT tools and decompress it there. You will
see a subfolder called “Import_TM?” containing six *.tmx files for each language pair.

e Create under the folder Creation_Maintenance two new subfolders: one called
“New_TM” (where you will store the new TM you will create later on during this
exercise) and another one called “Export_ TM” (where you will save the file
containing the results from the TM export)

You are now ready to start!



I. Creating a stand-alone TM
1. Getting started

As explained in the theory courses on Translation Memory Tools, it is possible to create a
stand-alone TM - not included in a particular project. In order to do so, follow the next steps:

e Start DéjaVu X
« InDe¢ja Vu X choose the Option New from the File menu
o From the New File dialog select Translation Memory and click on OK:
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e The New Translation Memory Wizard starts and guides you through the creation of
your translation memory



Mew Translation Memory Wizard

Welcome to the New Translation
Memory Wizard

This wizard helps wou to create a new Translation Memory For Deja
Yo,

To continue, click Mext,

< Back I Mexk = I Cancel

2. TM Specifications

e Click on Next and in the dialog box create your new translation memory, by clicking
on the Create button and specify a location and name for your TM. Choose the folder
New_TM you created at the beginning of this exercise. Enter a name in the field File
name, e.g. "eCoLoTrain_new_TM". The file name extension ".dvmdb" is added by
default.

Specify a Mame and Location
‘fou need ko specify the lacation af the new Translation Memaory,

In order to create a new translation memory, vou need ko specify where it will be
stored, Click Create to select the location and name of the new translation memary,

Select Name and Location of New Translation Memol 2=

Diateiname: IeEu:uLu:-T rain_new_Th | Speichem m
[exh = Zancel
Drateityp: ITransIatiDn b emories [*.dvmdb] LI Abbrechen | I
e
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e Save your settings by clicking Save and then Next. The translation memory wizard is
now completed.

Mew Translation Memory Wizard

Completing the New Translation
Memory Wizard

You have successfully completed the Mew Translation Memary
Wizard, Wou specified the Following Files;

Translation Memory; W deColoTrain_new_THM.dvmdb

To close this wizard, click Finish,

< Back l Finish *:ﬁl Cancel

3. Finish

Then click Finish to complete the creation of the TM. The new, empty, stand-alone
TM will open:



Deja ¥u X - [¥:\Workshop_SB'CAT tools'Creation&Maintenance'New_ TM'\eColoTrain_ = |EI|1|

ﬁ Eile Edit Wew Database Users Tools ‘Window Help _|E|5||
D@ ooy BRX. [,

Source Language: Target Language:

English {United Kingdaom) j II]Romanian j

Locake Sentence:

Filter:
gdd Remove Consolidate | Al Rows Duplicates Only QL. add Remove

Romanian I

English (United Kingdonm)

Date: Date:
User: User:

Subject
Client
Project
File
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Il. Import existing TM

1. Getting started

e Once your database created, go to the File menu, Import and select File or Database
from the menu — you could also import an alignment file, but for the purposes of this
exercise import a file containing an existing TM.

Deja ¥u X - [Y:'Workshop_SB'\CAT tools' Creation&Maintenance'New_TM.dvmdhb]
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The Translation Memory Import Wizard starts and guides you through the import of an
existing TM into your newly created TM. Click Next to continue.



Translation Memory Import Wizard

Welcome to the Translation Memory
Import Wizard

This wizard helps vou to import external data into the currenthy
open Deja Yu ¥ Translation Memory.

To continue, click Mext,

= Back I Mexk = I Cancel

2. Import Specifications

The Wizard will now ask you to specify the data format of the data you want to import. In this
example, the file to import is in the standard TMX format. Click Next to continue:

Translation Memory Import Wizard i

Specify Data Format
¥ou need to specify the format of the daka to import,

Frarm the list below, seleck the Format of the external daka yau want ba impart inko
the current Translation Memaory.,

Deja Yo ¥ Translation Memory
Dejavu 2% 3, % Memory Database
Text

Access 9597 2000/ %P

ODBC Daka Source

Excel 9597/ 2000/%F

Trados WE Database

IEM TM

< Back. I Mexk = I Zancel




Then, you will have to select the location of the file you want to import. The file containing
the existing TM that you will import is located under My Documents/CAT
tools/Creation&amp;Maintenance/Import_TM. There you will find several *.tmx files
containing translation databases in different language pairs (LO-en-de.tmx, LO_en-et.tmx,
LO_en-fr.tmx, LO_en-it.tmx, LO_en-ro.tmx and LO_en-sl.tmx). Choose one of them according
to your preferences, click Open and then Next.

Translation Memory Import Wizard

Specify File Name and Location ;;’
You need ko specify the name and location of the File waou wank Ea impart, i

Click Select to select the name and location of the THE File you wank to import inko the
current Translation Memary,

[ IMx File:

5e|ec|: Name and Location of TMX File e
Sucher in: I[':'} Import_TH j & B cf -

3 LO_en-de.trx
ﬂ LO_en-et.tmx
3 LO_en-fr.kmsx
B8 2] L0 en-it.tmx
L _en-ro.tmx
|3 LO_en-sl.trmx

Desktop

‘ = Back I Mexk = I Cancel

Eigene Dateien

Dateiname: |LD_en-m.th j Offnen SI
D ateityp: | TM24 Files (7 tme] =] Abbrechen |
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3. Language Conversion

The Wizard will ask you next to specify the language conversion since the file you are
importing was created in SDL Trados and language codes differ from those in DVX. Simply
select the language by language in the left pane by clicking, and choose a language with its
regional variant from the menu on the right field. Click Next to continue.



Translation Memory Imporkt Wizard

Specify Language Conversion

You need ko specify the how you want ko convert From the Trados language
codes inko Deja Yu ¥ languages,

Ilse the lists below to select how ko map the languages specified in the TR file to
Dieja Wu & languages.

Language Codes

ro Dl i

= Back I Mexk = I Cancel

4. Finish

e The Wizard will then complete the import process. For this, click Finish.

Translation Memory Import Wizard

Completing the Translation Memory
Import Wizard

You have successfully completed the Translation Memory Inpork
Wizard, You chose to import the Following file:

T File: Wit Import _TMLO_en-ro. b

To begin importing, click Finish,

% Back l Finish EI Cancel

e Now you have imported all entries contained in the *.tmx file into your empty TM.
Click Close to close the Wizard window.



Translation Memory Import Wizard

Completing the Translation Memory
Import Wizard

You have successfully completed the Translation Memory Inpork
Wizard. You chose to import the Following File:

TM¥ File: Yl A Impark_TRILO en-ro ks

The wizard successFully imparked 393 entries.,

5. Result

e After closing the Wizard, DejaVu X will display the TM containing now the imported
entries in the languages you selected.



Deja Yu X - [Y:\Workshop_SB%CAT tools' Creation&Maintenance’,New_TMieColoTr: ndb] j o ] 1

|
ﬁ] File Edit Yew Database Users Tools Window Help _|5’|5||
D@ v o $BARX. [H.
Source Language: Target Language:
English {United Kingdaorm) j |I]Romanian j

Locate Sentence:

Filter:

| i

&dd Remove Consolidsbe | afl pows Duplicates Onky - S0, Add Remove

English (United Kingdam) | | Romanian
B {1} versiuneaiz}

Copyright
@ Copyright 2003 SAP AG.

all rights reserved.

Mo part of this publication may be reproduced ar
transmitted in any form or for any purpose without
the express permission of SAP AG.

The information contained herein may be changed x|

Date: 17.03.2004 13:30:38 Date: 17.03.2004 13:30:38 %
User: noi_doi User: noi_doi

Subject
Client
Project
File:

| ‘% YiiwWorkshop_SBACAT toolsiCreationMaintenanceMew _TMieColaTrain_new_TM.dvmdb

I11. Maintaininga TM

1. Edit, Add, Remove
e Edit some segments if necessary
In order to edit the imported segments from your TM, double-click on the segment in the
corresponding language pane and edit the text. To save your changes, simply press the

ENTER key. It is worth noting that in other TM applications such as SDL Trados
different methods are used to edit segments.
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Deja ¥u X - [¥:\Workshop_SBCAT tools',Creation&Maintenance’New_THMieColoTrain_nes

=10l x|

JJ‘% Eile Edit Yiew Database Users Tools ‘Window Help _|E|ﬂ|
D2 | o | @ x. |&.
Source Language: Targek Language:

English {United Kingdarn) j I I]Romanian j

Locate Sentence:

Eilter:

| B

add Remove Copsolidate | all Rows Duplicabes Only SOL... add Remaove

English (United kingdam) | | Romanian I
Icon —! W Recomanda I

Mieaning

Caution

Example

Mote

(& ecommendation

Syntax LI

Date: 17.03.2004 13:30:39 Date: 17.03.2004 13:30:39
User: noi_doi User: noi_dai

Subject -

Client -

Project

File:

| ‘% Yi\wWorkshop_SBACAT toolsiCreationMaintenanceMew_ TMieColoTrain_new._ TM.dvmdb

e Add and remove segments

DVX offers you the possibility to add or remove segments by marking them in their
corresponding language pane and clicking then the Add or Remove buttons.
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Deja Yu X - [¥:\Workshop_SB'CAT tools\Creation&Maintenance\New_TM.dymdb] il

_(Ol ]
JJF'{I File Edit Wiew Database Users Tools window Help _|E|5||
T
D@ o g B@Rx . |&.
Source Language: Target Language:
English {United Kingdom) j II]Romanian j
Locate Senkence:

Filter:

[ Add Remove g]nsolidate Al Rows  Duplicates Only - 30L..,

English {United Kingdom}
Syritax

Add  Remove,

I;I Romanian
-l

Typographic Conventions

Type Style

Description

Words or characters that appear on the screen.

These include field names, screen titles,

pushbutions as well as menu names, paths and

options. hd|
Date: 17.03.2004 13:30:39

User! noi_doi

Date: 17.03.2004 13:30:39

User! noi_doi
Subject

Clignt
Project
File

| "-?['i Y1 itorkshop. SBVCAT toolsiCreationiMaintenance!hew_ TH, dymdb

| | e s e [ [,
2. Duplicates

e Search for duplicates

You can also search your TM for duplicate source sentences in one selected language
or for duplicate source sentences and their corresponding translations in order to edit
them. For this, go to the Database menu and select the option Find Duplicate

Sentences.

Find Duplicate Sentences .

Type

ﬂ Find Duplicate Sentences I ﬂ

1+ Find sets of duplicate source sentences
N3 5615 OF QUPICALE SOUCE Sentences with identical translations
I Delete redundant sentencesineach set of duplicates

{" Find seks of duplicate source sentences with different translations
Languages

| Delete redundant sentences in each set of duplicates
("' Find sets of duplicate: source sentences with diferent ranslations

Languages

j Source Language:

IEEnglish {United Kingdom) j

Source Language: English {United Kingdom)
Target Language: | ERomanian

Miscellanaous

j Target Language:

mRomanian j

[ lgniore case
[~ Tgnore pumerals
[ Ignore embedded codes

Cancel |

Miscellanaous

| Ignare case
[™ Ignore numerals
IV Iqnore embedded codes

oK bl Cancel |
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3. Merging

e Merge
Merging translation segments is another form of maintaining translation databases.

The Merge option (or Compact option in the new DVX version) allows you to merge
two identical source sentences with translations into different languages. Highlight
two source sentences by clicking on them while holding down the CTRL key and
click on the button Merge (or Consolidate) to try this function.

== Deja Yu X - [C:4 My ProjectMasterTerm.dytdb]
“ﬁ File Edit Wiew Database Tools Window  Help _|E'|£|

Source Language:

Related Terms:

|%English {United States) =] a =]
Locate Tetr: Targek Language:
IDeIete I,ﬁ,|| j

add Edit Remowe Merge allRows 3L, Add Edt Remove

Related Terms I

English {United States)

| delicited idertifiar I;I.Ellnanslal'.inr-
_1:

i BEgrenzungszeichen

delimiter

delimiter

delimiler

dENngUErT Fem

Malivg ~emakime Aok~ d
[ Attributes | | attributes |
L . L .

@ Clarity,doc @ index. hkml | ﬁ My ProjectiMaster Term. dvbdb
st | Asr | apr| Asd| ach|[ovR [21-0ja [4)1 [Current user: jost [Last madfied by: | 4/16/2003 3:59:115PM

The source records are merged into one record with several related translations.
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== Deja ¥Yu X - [CY My Project',MasterTerm.dvtdb]

J_lﬁ File Edit Wiew Database “ools Window  Help _|E|5|
D& oo BBRX . [F,

Source Language:; Related Terms:

|EEnglish {Urited States) =] Ja |
Locake Terrn: Target Language:

IDEIEI:E I.ﬁ.ll j

fdd Edit Bemove [eroe AllRows 30L.. Add Edit Remove

Englizh {Uritcd Skates) I = I Nelaked Torms I
deliritad-identifis: i

delimiter

s BEQrERZEF

OENnQUETTE Femn, B .- o enzungszeichen

Deliv.creation date [ Trennzeichen

Deliv. dake

At =i
| attributes | | Attributes |
n . L .

Clarity, doc :Ej index . hkml | ﬁj CMy ProjectiMaster Term, dvbdb

afs | Asr| aPr| asd| ach |[ovr [21-0j0 [1/1 [Current user: jost |Last modified by: | 4/16/2003 3:59

:ISPMJ

IVV. Compacting & Reorganising

1. Getting Started

Now that you imported new data into your TM, deleted, added and edited translation
segments you can compact or reorganize your TM. This is an automatic process that helps
you save disk space and increase your TM’s performance.

e To compact your TM, go to the Tools menu, point Compact and select the item
Translation Memory — you can also compact a Project or a Terminology Database.

Iu:n:uls. Window  Help

v sSpeling... F7
@ Character Map. .. ChelHK

LIzer Interface Language. ..

Converk g

Compack Projeck. ..

Repair Translation Memary. ..

Customizs:: Terminology Database. ..

options. ., Eilter. ..

o A dialog box opens and asks for the location of the TM. Browse and select the file
name with the extension .dvmdb. Click Open to open your TM.
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Select Mame and Location of Translation Memory 21x|

Suchen in; I@ Mew_TH j - =

eColaTrain_new_TH.dvmdb

D ateinarne: |eEu:-L-:uTrain_new_TM.dvmdl:u j
j Abbrechen

Dateityp: I Tranzlation Memaries [*.dvmdb]

Hilfe

]

2. Compacting Process

e The process of compacting your TM data will start. At the end click OK. Your TM
will be closed.
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”Eile Edit Users Tools JWindow  Help |

D@ oo | Bm@%. [,

-
\ 1) Compacting successful.

Compact Progress E.I

V. Exporting into TMX
1. Getting Started

e With the TM populated, maintained and compacted, you are ready to export it to the
standard format for exchanging translation databases - TMX.

o To export your translation database, open your TM again from DéjaVu X by going to
the File menu, clicking on Open, selecting the location of your TM and clicking the
Open button.

e Go to the File menu again, point to Export and click the File or Database menu item

16



Deja ¥u X - [Y:\Workshop_SB'CAT tools'Creation&Maintenance'\New_ TM.t

o =] 3
“q‘i,ge_ Edit Wiew Database Users Tools Window Help Aﬂﬁl
-“_D [ new... CrleM g
— & Open... Ctrl+0

Target Language:

j ﬁRomanian j

1 ..hew_TM.dvmdb
Filker
I_ 2 .. Mew_TMZ.dvmdb L
3 .. 4ew_TM1.dvmdb ﬁ
Add Exit Alb4Fe “ates Only SOL... Add Remove
English {United Kingdom) | | Romanian
Copyright

@ Copyright 2003 S4P AG.
all rights reserved.

Mo part of this publication may be reproduced or
transmitted in any form or for any purpose without
the express permission of SAP AG.

The information contained hersin may be changed x|

Date: 17.03,2004 13:30:38
User: noi_doi

Date: 17.03.2004 13:30:38
User: noi_doi

Subiject
Client
Project
File:

| ﬁ ¥iiWorkshop_ SBACAT toolsiCreationMaintenancetfew_TH.dvmdb

ans | ase | apr | asd | ach [0 [,

e The New Translation Memory Export Wizard starts and guides you through the
export of your translation memory. Click Next to continue:

Translation Memory Export YWizard

Welcome to the Translation Memory
Export Wizard

This wizard helps wou ko export data from the currently open Deja
Wu ¥ Translation Memory to an external file,

To conkinue, click Mext,

= Bach | Mext = |%I Cancel

2. Data Format, Name, Location
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o Specify the format of the data you want to export. There are several possibilities. For
this exercise choose the TMX format

Translation Memory Export Wizard i

Specify Data Format
You need ko specify the Farmat of the daka to export,

From the lisk below, select the Format to which you want to export data from the
current Translation Memary,

Deja o » Translation Memory
Text

Arccess 9597

Arccess 20000 %P

ODBC Daka Source

Excel 97/2000/%P

Excel 95)5.0

Excel 4.0

Excel 3.0

Trados WE Database

+ Back I Mexk = %I Zancel |

e Specify the file name and location where you want to save the export results file.
Select the folder Export_TM and enter a name for the export file in the File name
field, e.g. Export_ TM. Dé¢jaVu X selects by default the TMX format that you
previously specified.
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Translation Memory Egpmtjﬁéar_.ﬂs

Select Name and Location of THMX File el et

S peicherm I{_".' Ewport_Thd j A L

expork

Drateiname:; IE:-:pu:urt_TM Speicherm ;!
Dateitys: | Thi Files [*.tms) <] Abbrechen |

= Back I exk = I Zancel

3. Languages & Filtering

In the next step you will need to specify the languages that you want to export from
your TM. In the TM vyou created, you have data in two languages. Select the
corresponding languages and sublanguages by marking them in the left-pane and
clicking the Add button. After having selected languages to export, click Next.

Translation Memory Export Wizard .

Specify Languages
‘fou need to specify the languages that you want to export from the current

Translation Memary,

Ilz& the Add and Remaowve butkons ko select the languages wou wank ko expaork,

Export languages:
English [United Kingdom)

Available languages:

add -

- Remove

|

< Back I Mext = I Zancel
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e In case you want to specify some filtering conditions to apply to the data you are
exporting you can define them in the Wizard window on Filtering Conditions:

Translation Memory Export Wizard

Filtering Conditions

You need ko specify any filkering conditions ywau want ko apply b the daka wau
are exparking.

In the text box below, tvpe any filkering conditions waou may want ko apply before
exporting the data. These conditions must be specified in the same Format as an 0L
WHERE clause. Check the documentation for more information. Use the Yalidate
button to check the filker syntax before proceeding,

Filteting conditions:

< Back I Mext = %I Cancel

4. TMX Options

o DéjaVu X offers the option to specify the format of the TMX-data you want to import.
You can choose e.g. from a UTF16, UTF8 and 1SO-646 format. For this exercise
choose the UTF8 format. Click then the Next button.
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Translation Memory Export Wizard ]

TMX Options
You need to specify the Format of the data to export,

Fram the list below, select the Format to which wou want to export daka From the
current Translation Memory.

Encoding Extra Information
" UTF1a ¥ subject

itk W Cliert
" 150-646 [US-ASCIT] {7-hit File) V¥ Project
Iv File
v Raw
v Is Source
¥ Date

v Lser

< Back. l Mexk = \_E I Zancel

5. Finish
e Click Finish to complete the export of your translation database data.

Translation Memory Export Wizard

Completing the Translation Memory
Export Wizard

¥ou have successfully completed the Translation Memory Export
Wizard, You chose to export to the following file:

T File: Wil AExport_TMYExport TR, kb

To begin exporting, click Finish,

< Back l Finish %I Cancel

e Asaresult of the export process, a new file containing your translation database in the
standard exchange format TMX is created:
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I Grifie I Typ
% 306 KB TMX-Datei

Tvp: TMx-Dakei
Grife: 305 K6
Gedndert am: 24.07.2006 19:14

End of exercise 111

Congratulations! You have successfully completed exercise Il of the eCoLoTrain Translation
Memory module.
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